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What the elder person is followed by others;
What he demonstrates by action that people follow”

-Bhagwad Gita
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CHAPTER - 1

SYSTEM ORGANIZATION
BASIC COMPONENTS

A computer is nothing more than various individual hardware components
connected to each through cables and the motherboard. These devices are then given
electricity by the power supply unit so that they can function. In this section we will
discuss the individual components and the function that each performs.

INPUT DEVICE

The process of accepting the information or data given by the user is called Input.

The devices through which the information is accepted is called Input devices.

The common Input Devices are Keyboard, Mouse, Light Pen, Joystick, Touch Panel,

Microphone, Scanner, Digital Camera etc.

Keyboard

Most common and very popular input device is keyboard.
The keyboard helps in inputting the data to the computer. The
layout of the keyboard is like that of traditional typewriter,
although there are some additional keys provided for performing
some additional functions.

Keyboards are of two sizes 84 keys or 101/102 keys, but now 104 keys or 108
keys keyboard is also available for Windows and Internet.

Mouse

Mouse is most popular Pointing device. It is a very
famous cursor-control device. It is a small palm size box with
a round ball at its base which senses the movement of mouse
and sends corresponding signals to CPU on pressing the
buttons.

Generally, it has two buttons called left and right button and
scroll bar is present at the mid. Mouse can be used to control the position of cursor on
screen, but it cannot be used to enter text into the computer.
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OUTPUT DEVICE

The process of executing the information or data after processing is called Output.

The device through which the information is executed is called Output Device.

The common Output Devices are Monitor, Printer, Speaker, Plotter, Projector etc.

Monitors

Monitor commonly called as Visual Display Unit
(VDU) is the main output device of a computer. It forms
images from tiny dots, called pixels that are arranged in a
rectangular form. The sharpness of the image depends upon
the number of the pixels.

There are two kinds of viewing screen used for monitors:
 Cathode-Ray Tube (CRT)
 Flat-Panel Display

Printers

Printer is the most important output device, which is used to print information on paper.

There are two types of printers:
 Impact Printers
 Non-Impact Printers

Impact Printers

The printers that print the characters by striking against the
ribbon and onto the paper are called impact printers.

These printers are of two types:
 Character printers
 Line printers

Non-impact Printers

The printers that print the characters without striking
against the ribbon and onto the paper are called Non-
impact Printers. These printers print a complete page at a
time, also called as Page Printers.

These printers are of two types:
 Laser Printers
 Inkjet Printers
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COMPONENTS OF THE CPU

Computer Case

The computer case also called a cabinet, houses and protects other core parts of
the computer. Computer cases come in different sizes and shapes in order to
accommodate the various environments that they will be stored in. These shapes are:

 Tower

 Desktop

 Rack mount

Tower Case Rack Mount
Motherboard

The motherboard, or mobo for short, is
perhaps the most critical piece of the
computer. It is a relatively large, rectangular
board filled with various circuits, chips, and
slots that you plug things into the motherboard
serves two functions. First, the motherboard is
home to a number of chips that dictate how the
various components of the computer will talk
to each other. Secondly, and perhaps most
importantly, the motherboard is the connecting
point for all of the other pieces of the computer. Without the motherboard, the different
parts cannot communicate with each other, and the computer cannot function.

Central Processing Unit

The central processing unit, or CPU, is at the core
of every computer. Functioning as the "brain" of the
computer, the CPU performs basic mathematical and
logical functions as instructed by a computer program.
The CPU is located on the motherboard and is connected
to it through a special port called the CPU socket. When
the CPU is in use it generates heats, which must be
transferred away from CPU chip so that it is not damaged.
This is accomplished through the use of a heat-sink and fan
which draws the heat out of the CPU chip and transfers it into the case instead.



7th Standard P a g e | 4

KARNATAK RESIDENTIAL EDUCTIONAL INSTITUTIONS SOCIETY, BANGALORE

Cooling Devices

As a computer runs, it generates a lot of heat. One or
more cooling devices are part of any modern computer in
order to keep the machine from overheating. The two types
of cooling devices that are in almost every modern
computer are heat sinks and cooling fans.

Heat sinks are small metal structures that conduct
heat well. They function by absorbing the heat produced by
a component and efficiently releasing it into the air, or a
liquid in certain special situations, similarly to how the radiator in your car works.

Cooling fans work by removing warm air from components or heat sinks and
pulling in cool air to replace it.

Power Supply Unit

All parts of a computer require electricity in order to
operate. The part of the computer that provides this
electricity is called the Switch Mode power supply unit, or
SMPS. The SMPS receives electricity from an external
source, which is usually a wall outlet, and changes it into
power that the other parts of the computer can use.

Hard Disk Drive

The hard disk drive, or HDD, is the primary source of secondary
storage in modern computers. An HDD uses magnetism to record
information on a rotating disk of magnetic material. It uses a moveable
arm containing a device called a drive head to read from and write to
different portions of the disk.

Optical Disk Drives

An optical disk drive is a component that uses a laser to read
from or write to an optical disk. Examples of optical disks include
CDs, DVDs, and Blu-Rays.

Memory
Random Access Memory, or RAM, is the part of the

computer where information is stored while it is being used by
the computer's processor, operating system, programs, and other
devices on your computer.
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FRONT VIEW OF COMPUTER

On the front of the computer
you will commonly find a CD or DVD
drive that can be opened by pressing a
small button near the door of the drive.
This will eject the drive tray where
you can place a CD or DVD disk.
When you press the button again, the
tray will slide back into your computer
so that you can access it from within
your operating system.

On the front of the computer
case, you will see a Power Button and
Restart Button which is used switch on
the CPU.

On the front of the case, you will also typically find USB ports and media readers.
A USB port is a small opening on the front of your computer that allows you to plug a
USB device or cable into it.

REAR VIEW OF COMPUTER

On the back of the case are
connectors that are typically only used
when you assemble your computer for
the first time. These connectors allow
you to connect external devices such as
your printer, monitor, mouse, keyboard,
and speakers.

The back connections will also
include an Ethernet port that will allow
you to connect your computer to your
network. Last, but not least, there will
also be more USB ports available in the
event that you need more USB

connections than are available on the front of your computer.
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INSIDE VIEW OF COMPUTER CASE

Once you open up a computer case, it can initially be difficult to recognize the
various components, in particular due to all the different wires; however, if you look
closely, you will probably start to recognize a number of components. The figure below
labels some of major ones.

LIMITATIONS OF COMPUTER

Computer has done this and that. Actually this is not the computer which has
done this but the user. Despite its various features, a computer does have the following
limitations:

I. No Self Intelligence
Today, computer is able to do a work which is impossible for man. Computers are
used to do risky and dangerous work and where sharp actually is needed. But it
does not have any intelligence of its own. It works according to the instruction
only.

II. No Decision-Making Power
Computer cannot take any decision of its own. It does only those tasks which are
already instructed to it.

III. No Learning Power
Computer has no learning power. Once you give instructions to a computer how
to perform a task, the very task is cannot perform if you do not give it
any instructions for the next time. For example, when you are taught how to solve
a problem and it same type of problem is given to you to solve, then you can do it
because you have learned how to solve the problem.
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CHAPTER - 2

INTRODUCTION TO MS-WORD

INTRODUCTION

A word processor is application software, developed for the purpose of text
processing. A word processor package helps the user to create, edit and perform various
operations on documents. Creating document involves typing in it the internet memory of
the computer and transferring it by saving it on the storage disk. Editing a document
involves the operation of correcting the spelling mistakes, indenting paragraph, deleting
or moving words, sentences or paragraphs and so on. The use of the word processing
system has many advantages over a manual system. Some of the advantages are:

1. Since the character is created on the screen, correcting of mistakes can be done
easily.

2. The number of copies of outputs of the document, which can be taken, is
unlimited.

3. Formatting of a document can be performed automatically.
4. Special functions such as spell checking find and replace, indexing and table of

contents can be easily performed.
5. Mail merge is the most important feature of word processing system.

STARTING MS-WORD

This will show you how to start Microsoft Word:

1.   Click the Start button - the Start menu appears
2.   Point to the entry for All Programs
3.   Click on the entry for Microsoft Office – Word 2007

The Microsoft Word program will load, and a blank document will appear on your screen.
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AN OVERVIEW OF MS-WORD

The MS Word window

If you’ve used previous versions of Word, you’ll notice that the old menu system
has been replaced by the Ribbon and the Office button.

 The Office button contains a menu of file-related commands. Click the Office
Button to see the available commands. Select a command by clicking on it.

 The Quick access toolbar provides a set of frequently used commands. The default
options are to save a file, to undo the last action, and to repeat your most recent
action.

 The Ribbon tabs provide you with a set of tools that are relevant to what you are
currently doing. In the example above, the Home tab contains formatting and
editing options.

 The Title bar displays the name of the program and the name of the current
document. If you haven’t named the document yet, then it will be called
something like Document1.

 Window controls are used to change the size of a window, or to close it.

 The Vertical scrollbar is used to scroll up and down the page. You can also click
on the little down arrow below the scrollbar to move down the page.

 The Status and information bar displays useful information about your document,
such as the page count and number of words.
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CREATING AND OPENING DOCUMENT

There are several ways to create new document, open existing documents and save
documents in MS-Word

Creating a New Document

The steps involved in creating a new document are

1. Click the Office button
2. Select the New option, followed by Blank Document.
3. OR Press Ctrl + N (Press the Ctrl key while pressing “N”) on the keyboard.

Open an Existing Document

The steps involved in creating a new document are

1. Click the Office button
2. Select the Open option.
3. OR Press Ctrl + O on the keyboard
4. Each method will show the Open dialog box. Choose the file and click the Open

button.

Saving a Document

The steps involved in creating a new document are

1. Click the Office button
2. Select the Save option
3. OR you can use the keyboard shortcut: Press Ctrl + S.

Closing a Document

The steps involved in creating a new document are

1. Click the Office button
2. Select the Close option
3. OR you can use the keyboard shortcut: Press Alt + F4.
4. Click the Close icon if it’s visible on the Standard Toolbar.
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TYPING AND INSERTING TEXT

To enter text, just start typing. The text will appear where the blinking cursor is
located. Move the cursor by using the arrow buttons on the keyboard or positioning the
mouse and clicking the left button. The keyboard shortcuts listed below are also helpful
when moving through the text of the document.

MOVE ACTION KEYSTROKE

Beginning of the Line

End of the Line

Top of the Document

End of the Document

Home

End

Ctrl + Home

Ctrl + End

Selecting Text

To change any attributes of text it must be highlighted first. Select the text by
dragging the mouse over the desired text while keeping the left mouse button depressed,
or hold down the Shift key on the keyboard while using the arrow buttons to highlight the
text. The following table contains shortcuts for selecting a portion of the text.

Deselect the text by clicking anywhere outside of the selection on the page or
press an arrow key on the keyboard.

SELECTION TECHNIQUE

Whole Word

Whole Paragraph

Several words or Lines

Entire Document

Double Click within the word

Triple click within the Paragraph

Drag the mouse over the words or hold
down Shift while using the arrow keys.

Choose Select option followed by Select
All  in menu bar OR Press Ctrl + A

Deleting a Text

Use the Backspace and Delete Keys on the keyboard to delete text. Backspace will
delete text to the left of the cursor and Delete will erase the text to the right. Delete a
large selection of text, highlight it using any of the methods outlined above and press the
Delete.
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Cut, Copy & Paste:
Cut, Copy and Paste are some of the most practical features of a word processor.

Cut and Paste

1. Select the relevant text or object.
2. Click the Cut button on the Home ribbon – its icon is a pair of scissors.
3. Place the cursor at the point where you’d like to add the text.
4. Now click the Paste button – its icon is a picture of a clipboard.
5. If necessary, add an extra space at the end of the pasted text.

Copy and Paste

1. Select the relevant text or object.
2. Click the Copy button on the Home ribbon – its icon is a pictured of a

clipboard.
3. Place the cursor at the point where you’d like to add the text.
4. Now click the Paste button – its icon is a picture of a clipboard.
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CHAPTER - 3

INTRODUCTION TO INTERNET

INTERNET

The internet has revolutionized the world of computing. But the ‘network of
network’ did not emerge overnight. The story of its evolution began almost 50 years.

History of Internet

The foundation of the internet was laid in the year 1957 when the cold war started
between US and Soviet Union. After much research, a distributed network called
ARPANET was built in the year 1969. This connected computer at University research
centers. Plans for a new technique called TCP/IP (Transmission Control Protocol/Internet
Protocol)

The term ‘Internet’, was coined in the year 1982. In the year 1991 NSF (National Science
Foundation) lifted the restricted imposed on the commercial use of the net.
Advertisements were allowed. It became a beautiful cosmos of Text, Graphics, Sounds
and Videos.

What is Internet?

Internet stands for International Network. It connects computer networks (LANs
WANs and MANs) and PCs all over the world together by means of wires, telephone
lines, cables.

Requirements to get Internet Connection

 A Well configured System

 A Modem

 Telephone Line

 ISP

 Web Browser

Applications of Internet

 Access a wealth of information, news and research material.

 Communicate with others around the world.
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 Bank and invest.

 Shop for goods and services.

 Download and listen to music or download and watch movies.

 Take a course or access other educational material.

 Access sources of entertainment and leisure such as online games, magazines
and holidays planning guides.

 Access other computers, mobile phones or PDA and exchange files.

 Share and edit documents with others in real time.

 Provide information, photographs, audio clips or video clips.

INTERNET SERVICES

To support these and other activities, the Internet provides a variety of services that
include:

 WWW (World Wide Web)

 E-mail

 Instant messaging

 Chat rooms
 Newsgroups

1. WWW: The WWW is just one of the many services available on the Internet
(the Internet developed in the late 1960s, the WWW in the early 1990s).
However it became the most widely used service on the Internet. It consists of a
worldwide collection of electronic documents (web pages).

2. E-Mail (electronic mail): The transmission of messages electronically. E-mail
can be limited to a single computer system or network, or can allow much broader
connectivity. Most e-mail systems allow you to send the same message to one or
many people.

3. Instant messaging (IM): It is a real-time Internet communications service that
notifies you when one or more people are online and then allows you to
exchange messages or files or join a private chat room with them. To use IM you
install software from an instant messaging service, sometimes called an instant
messenger (ICQ, Skype, AIM, and MSN). Instant messaging is by far the most
common form of communication in recent times; it can exchange text, voice,
and video.
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4. Chat room is an online forum where people can chat online talk by broadcasting
messages to people on the same forum in real time.

5. Newsgroups: A newsgroup is an online area in which users conduct written
discussion about a particular subject. To participate in a discussion, a user sends a
message to the news group, and other users in the newsgroup read and reply to
the message.

BASIC INTERNET TERMS

Browser -Contains the basic software you need in order to find, retrieve, view, and send
information over the Internet.

Download- To copy data from a remote computer to a local computer.

Upload- To send data from a local computer to a remote computer.

Home Page - The beginning "page" of any site.

HTML (HyperText Markup Language) - The coding language used to create
documents for use on the World Wide Web. There are three-letter suffixes used in
coding that help to identify the type location one is viewing

HTTP (HyperText Transport Protocol) - The set of rules for exchanging files (text,
graphic images, sound, video, and other multimedia files) on the World Wide Web.
Relative to the TCP/IP suite of protocols (which are the basis for information exchange
on the Internet), HTTP is an application protocol.

Search Engine - A web server that collects data from other web servers and puts it into a
database (much like an index), it provides links to pages that contain the object of your
search.

TCP/IP -- TCP/IP (Transmission Control Protocol/Internet Protocol) is the basic
communication language or protocol of the Internet. It can also be used as a
communications protocol in a private network (either an intranet or an extranet).

URL (Uniform Resource Locator) - The Internet address. The prefix of a URL
indicates which area of the Internet will be accessed. URLs look differently depending
on the Internet resource you are seeking.
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CHAPTER - 4

FORMATTING IN MS-WORD
Word provides an amazing range of tools to help you create professional-looking

documents! Characteristics that affect the appearance of one or more characters are
called character formats.

CHANGING THE FONT

The style of typeface that you use is called the
font, and there are literally hundreds to choose from!

To change your font:

1. Select the relevant text. This can be anything
from a single character to the entire document.

2. Find the Font field on the Home ribbon.
3. Click the drop-down arrow next to the Font

field.
4. Select the font you want by clicking its name.

To Change your font size:

You can change the size of the font to suit your needs:

1. Once again, first select the relevant text.
2. Find the Point Size field on the Home ribbon, and click the drop-down

arrow next to it.
3. On the list, find the font size that suits you and click it.

You can also specify your own font size. Just click in the Point Size field and type in the
size that you’d like, then press [ENTER]. The size must be between 1 and 1638, and can
include “half sizes” such as 12.5.
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Bold, italic, and underline

The steps involved for changing the selected text to Bold, Italic and Underline are.

1. Select the relevant portion of your text.
2. Click the appropriate character formatting button on the Home ribbon.

for Bold

for Italic

for Underline !
The arrow next to the underline button offers you a choice of underlining styles.

3. To turn a character format off, click the same button again.

Change the text color

You can apply a format to selected text, or you can quickly and easily format an
entire document to give it a professional and modern look by applying to a document.

1. Select the text that you want to change,
2. Move your pointer to the toolbar that appears with your text selection.
3. Click Font Color, and then select the color that you want.

ALIGNMENT:

By default, texts are usually left-aligned. The left
margin is straight, but the right margin is jagged (like in
this manual). Word provides you with a number of other options though. Just position
your cursor anywhere in the paragraph, and click one of the text alignment buttons on the
Home ribbon.

 Align left: Text is aligned at the left margin but jagged on the right.

 Center: Text is centered within each line, with jagged margins on both
left and right.

 Align right: Text is aligned at the right margin but jagged on the left.

 Justify: Text is aligned at both the left and right margins.

Note: You can select multiple formatting characteristics at the same
time, for example by clicking Bold and then Italic.
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PARAGRAPH

Paragraph formatting applies to a complete
paragraph - that is, all the text between two occurrences of
[ENTER]. And you don’t even need to select the text first,
unless you want to format more than one paragraph. Just
position your cursor anywhere inside the paragraph that
you want to format. It’s as simple as that!

Working with indents

If you are working with a long document, you might want to consider setting off
certain sections of text by using indents. Indents allow you to set text within a paragraph
at different margins.

There are 4 different types of indents:

First Line
Use this option to move the first line of your paragraph to the
right

Hanging
Use this option to control the left margin of every line in your
paragraph except the first one

Left
Use this option to move the left margin of your paragraph to the
right.

Right
Use this option to move the right margin of your paragraph to the
left.

First Line Indent

1. Click in front of the line that you want to
indent.

2. On the Page Layout tab, click Paragraph, and then Indents and Spacing
3. In the Special list under Indentation, click First line, and then in the By box, set

the amount of space that you want the first line to be indented.

Hanging Indent

1. Select the paragraph in which you want to indent all but the first line of the
paragraph

2. On the Page Layout tab, click Paragraph, and then Indents and Spacing
3. In the Special list under Indentation, click Hanging, and then in the By box, set the
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amount of space that you want for the hanging indent.

Setting left and right indents

1. Select the paragraph that you want to change.
2. On the Page Layout tab, click Paragraph, and then Indents and Spacing
3. Click the arrows next to Indent Left / Right to increase / decrease the left / right

indentation of the paragraph.

Working with line spacing

Change the spacing before and after selected paragraphs. By default, paragraphs
are followed by a blank line, and headings have extra space above them.

1. Select the paragraph before or after which you want to change the spacing.
2. On the Page Layout tab, in Paragraph, click arrow next to Spacing Before or

Spacing After and enter the amount of space required.

Line spacing options

Single Default option - sets line spacing to one line

1.5 lines This option is one-and-one-half times that of single line spacing.

Double This option is twice that of single line spacing.

At least This option sets at minimum amount of space between lines

Exactly This option sets fixed line spacing, expressed in points.

Multiple Sets the line spacing to accommodate multiple lines

Change the line spacing for paragraphs

1. Select the paragraphs for which you want to change the line spacing.
2. On the Home tab, in Paragraph, click Line Spacing
3. Click on Line Spacing Options, and select options you want under Spacing.
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BORDERS AND SHADINGS

Borders can add interest and emphasis to various parts of your document. You can
add borders to pages, text, tables and table cells, graphic objects, and pictures. You can
also add a border to any or all sides of each page in a document, to pages in a section, to
the first page only, or to all pages except the first. You can add page borders in many line
styles and colors, as well as a variety of graphical borders.

You want to place a border around an entire paragraph:

1. Place the cursor anywhere in the paragraph that you’d like to frame.
2. Click the Outside Borders button in the Paragraph section of the Home Ribbon.

(Note: if the Outside Border button doesn’t show a “frame” icon, then
Click the drop-down arrow to select it.)

For more borders and shading:

1. Select the Page Border option in the Page Layout ribbon
tab.

2. This will open the Borders and Shading dialogue box.
3. Effects can be applied to the whole paragraph, or to

selected words.

Using the Borders tab, you can select a border setting,
style, color and width. The Apply To field lets you specify
whether this should be applied to the whole paragraph or to
selected text. Click OK to see the effect.
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Using the Shading tab, you can select a background color and/or pattern. The
Apply To field lets you specify whether this should be applied to the whole paragraph or
to selected text. Click OK to see the effect.

BULLETS AND NUMBERING

This allows you to create lists within your document
that can be organized with bullets or numbers. Lists are
useful for presenting text that wouldn’t make the most
sense in paragraph form (for example, step-by-step
instructions) or for emphasizing key points. Bullets are
usually small circles at the beginning of item in a list, and
numbers are used for lists that are arranged in sequential
order.
Here’s an example of a bulleted list:

 Bananas

 Milk

 Eggs

 Ice Cream

To create a list:

1. On the Home tab, select either the Bullets or Numbering buttons from the
Paragraph group.   If you want to choose a particular style for your bullets or
numbers, click on the triangle next to the button and choose a style from the menu
that appears.

2. You will see the first bullet or number appear on your document.   Type your first
line of text and then hit Enter.

3. Another bullet or number will appear automatically.   Type your next line of text
and hit Enter.

4. When you have finished your list, hit Enter twice to end the bullets or numbering.

PAGE SETUP

Page Margin

The Page Margins of the document can be changed using the rulers on the page
and Page Layout Ribbon Tab.



7th Standard P a g e | 21

KARNATAK RESIDENTIAL EDUCTIONAL INSTITUTIONS SOCIETY, BANGALORE

The steps involved in change the Page Margin of your
Document are

1. Select Page Layout, then Margins.
2. The most common margin width to use is the Normal

Option. You are also welcome to select your own margin
settings by selecting Margins, Custom Margins.

The steps involved in change the Page Margin of your
Document using the ruler method is:

1. Move the pointer over the area where the white ruler.
2. When the cursor becomes a double-ended arrow, click the

mouse and drag the margin indicator to the desired
location.

3. Release the mouse when the margin is set.

Page Orientation

You can change the Page Orientation of your document

Step:
1. Select the Page Layout ribbon tab
2. Select the Orientation
3. Choose the Portrait or Landscape

Page Size

You can change the Page Size of your document

Step:
1. Select the Page Layout ribbon tab
2. Select the Size option
3. Choose the Paper size in the list or click

More Paper size option.

HEADER AND FOOTERS

A header is text that is added to the top of the margin of
every page such as document title or page number and Footer is
text added to the bottom margin.
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Follow these steps to add or edit the header and footer in the document.

1. On the Insert ribbon, click the Header/Footer button.
2. The Header/Footer menu will drop down, offering you a choice of built-in header

layouts. Select a layout by clicking on it.
3. The header/footer area will appear above/below your document text (which will

be grayed out).The Design ribbon will replace the Insert ribbon above the
document window.

4. You’ll see a text placeholder in the header/footer area. Click on it and then type
the text that you want to appear in the header.

5. When you’ve finished creating your header/footer, click the Close Header and
Footer button.

To edit an existing header, just double-click anywhere in the header area. To
remove a header, Click the Header/Footer button and then select Remove Header/Footer
from the bottom of the drop-down menu.

PRINT PREVIEW

Preview is a option which helps the user to see the document on the screen in a
representation of one or more pages of the document before printing them. The view
provided is similar to the output which may appear on the sheet of paper which a print of
the document is taken

The steps required to Print Preview a document are:

1. Click the Microsoft Office Button
2. Point to the arrow next to Print
3. Then click Print Preview.
4. The print preview window as show in the figure below is displayed.
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PRINT WINDOWS OPTION

The steps to print a document are:

1. Click the Microsoft Office Button , and Point to the arrow next to Print
2. Then click Print option or Press Ctrl + P shortcut Key

The Print dialog box is displayed

1. Select the Printer on which you want to print the document in the Name text box.
2. Select one or more options, which are highlighted below.

Print to File: Prints the document to file on the disk

All: Prints all the pages of the document

Current Page: Prints only the current page of the document

Pages: Prints the range specified.

Number of copies: Prints as many copies of the document as specified.

1. Select an option from the Scale to Paper size drop down list and select the Paper
size.

2. Click on the OK button to send copies to the Printer.
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CHAPTER - 5

ELECTRONIC MAIL

WHAT IS EMAIL?

Email is a shortened term for “electronic mail.” Email is a system of world-wide
electronic communication where a computer user can compose a message at one terminal
and that message can then be read at the recipient's terminal when the recipient logs in.

WHY USE EMAIL?

 Communication: Email allows for the sending,
receiving, and storing of electronic messages.

 Speed: Email gives us the ability to contact any person
in the world in a matter of minutes.

 Convenience: Email allows for the attachment of
documents, such as a resume or a photograph.

HOW EMAIL WORKS

To use email, you will need a computer with an Internet
connection, an email account with your own email address, and the
email address of the recipient.

Email accounts are on the web, so you can access your email from any computer
with an Internet connection. There are several free email services on the web. Two of the
most popular include:

 Yahoo: mail.yahoo.com

 Gmail (Google mail):  gmail.com

EMAIL ADDRESSES

An email address is what identifies an electronic post office box on a
network where email can be sent. Example: kreis@yahoo.com

Every email address has three parts: kreis@yahoo.com breaks down like this:

 A user name or user ID: kreis

 An “at” sign: @
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 The domain name or the address of the email service where the user’s email
account is located: yahoo.com

 The domain name could also be .org, .edu, .gov, etc.

EMAIL MESSAGES

Every email message has a header and a body:

The header of a message contains blank fields for you to fill in:

 To: The e-mail address of recipient. Be sure to type the address exactly— any
typo will cause the message not to be sent. You can put more than one email
address in the “to” field by separating the addresses with commas.

 CC (carbon copy): the e-mail address of anyone who is being carbon copied—
that is, if there are multiple recipients who should be aware of the email’s contents
but are not the addressees. Does not need to be filled in to send.

 BCC (Blind Carbon Copy): Bcc addresses are hidden from messages sent to
people on the To: and Cc: lists. Does not need to be filled in to send.

 Subject: indicates the message topic. Try to be brief and to the point. Does not
need to be filled in to send, but it’s a common practice to do so because it alerts
the recipient as to the content of the message.

The body of the message is the text of the message itself.

RECEIVING, REPLYING, AND SENDING:

 Inbox: is the “mail box.” New messages appear at the top of the inbox and are in
bold print. When you want to check your mail:

o Click on the message to read it.
o You can keep messages in your inbox, move them to a folder, or delete

them.

 Send: is the command to deliver your message once it’s composed.
 Reply: is responding to a message you’ve received. The address of the person who

sent the message to you will automatically appear in the “To” field.
 Reply All: If there is more than one recipient and you only hit “reply,” then only

the sender will receive your response. If you want to reply to everyone, choose
“reply all.”

 Forward: Send the text of the email to a different person(s).

 New: Choose this when you want to compose a new message. Fill in the fields,
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type your message, and press send.

When you go into a Yahoo inbox, it will look something like this:

ATTACHMENTS

 Sending: Can attach photos or text documents to an email message
o From a PC: can attach files from hard drive (or c: drive)

 Receiving: Can view an attached item someone sent you
o Click on attachment. Choose open or save.
o Beware of opening attachments because this is how viruses can be

transmitted. These days, most PCs are set up with virus scan, but it’s still
better not to open an attachment unless you know who sent it.

Folders: How your mail is organized

 Inbox: Incoming messages are stored here until deleted or moved
to a sub-folder. You can create sub-folders in your inbox in a
section called “my folders.” (School, family, etc.) As you see fit.

 Sent: Similar to an “out box,” messages you have sent are stored
here.

 Spam: Junk mail. If you receive junk mail in your inbox, mark it as spam and any
other correspondence from that sender will be directed there.

 Trash: Messages that have been deleted stay here until the trash is emptied.
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How to Create Your E-mail Account

1. Go to mail.yahoo.com
2. On the right-hand side of the page, you will see

3. Click “Sign Up.” for setting up your Yahoo account.
4. You will need to fill out three sections and enter a

security code:

 “Tell us about yourself” (name, etc.)
 “Select your User ID and password “(You will

need to create these; it’s a good idea to have a
couple of choices for User ID because your
first choice might not be available).

 “In case you forget your User ID and password” (security questions)
 “Just a Couple More Details: Enter the Security Code and Check the box to

agree to Yahoo Terms of Service.

Don't have a Yahoo! ID?
Signing up is easy.
Sign Up
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CHAPTER - 6

NUDI 4.0
£ÀÄr DgÀA¨sÀ

 `£ÀÄr'AiÀÄ C£ÀÄ¸ÁÜ¥À£É DzÀ PÀÆqÀ̄ É ¥ÀæzÀ±ÀðPÀvÉgÉ
(ªÀiÁ¤lgï) ªÉÄÃ¯É Nudi 4.0 JA§
¯ÁAbÀ£ÀªÀÅ (Icon) ªÀÄÆrgÀÄvÀÛzÉ.

 `£ÀÄr'AiÀÄ£ÀÄß JAJ¸ï ªÀqïð CxÀªÁ EvÀgÀ
vÀAvÁæA±ÀUÀ¼À°è §¼À̧ À®Ä `Nudi 4.0' ªÉÄÃ¯É
eÉÆÃr QèPï ªÀiÁr.

 `£ÀÄr' ¯ÁAbÀ£ÀªÀÅ ¥ÀæzÀ±ÀðPÀzÀ PÉ¼À CAa£À §®
ªÀÄÆ¯ÉAiÀÄ°è PÁtÂ¹PÉÆ¼ÀÄîvÀÛzÉ.

 `£ÀÄr ¥ÀzÀ̧ ÀA¸ÁÌgÀPÀ' §¼À̧ À®Ä ¥ÀæzÀ±ÀðPÀzÀ PÉ¼À CAa£À §®ªÀÄÆ¯ÉAiÀÄ°è PÁtÂ¹PÉÆ¼ÀÄîwÛgÀÄªÀ `£ÀÄr'
¯ÁAbÀ£ÀzÀ MªÉÄä QèQÌ¹.

 `£ÀÄr' §¼ÀPÉUÉ ¹zÀÞªÁzÁUÀ QÃ°ªÀÄtÂAiÀÄ ªÉÄÃ°£À SCROLL LOCK ¸ÀAPÉÃvÀ ¢Ã¥À
ºÉÆwÛgÀÄvÀÛzÉ. EzÀ£ÀÄß ºÉÆwÛ¸À®Ä/Dj¸À®Ä SCROLL LOCK QÃ°AiÀÄ£ÀÄß MwÛj. £ÀÄrAiÀÄ 4.0
£ÉAiÀÄ DªÀÈwÛAiÀÄ°è SCROLL LOCK QÃ §zÀ®Ä F12 QÃAiÀÄ£ÀÄß §¼À̧ À§ºÀÄzÀÄ. FUÀ £ÀÄr
vÀAvÁæA±ÀªÀÅ §¼ÀPÉUÉ ¹zÀÞ.

QÃ°ªÀÄuÉ «£Áå¸À

F QÃ°ªÀÄuÉ «£Áå¸À PÀ£ÁðlPÀ ¸ÀPÁðgÀ ¤UÀ¢¥Àr¹gÀÄªÀ ²µÀÖvÉUÉ C£ÀÄUÀÄtªÁVzÉ.
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¥ÀzÀ̧ ÀA¸ÁÌgÀPÀzÀ §¼ÀPÉ
F ¥ÀzÀ ¸ÀA¸ÁÌgÀPÀªÀÅ WORDPAD ¥ÀzÀ ¸ÀA¸ÁÌgÀPÀªÀ£ÀÄß §ºÀÄªÁV ºÉÆÃ®ÄvÀÛzÉ. F

¸ÀA¥ÁzÀPÀªÀ£ÀÄß §¼À¹ £ÁªÀÅ AiÀiÁªÀ jÃwAiÀÄ PÀqÀvÀªÀ£ÀÄß ¹zÀÞ¥Àr¸ÀÄvÉÛÃªÉ JA§ÄzÀ£ÀÄß
¤zsÀðj¸À®Ä¸ÀºÁAiÀÄPÀªÁzÀ DAiÉÄÌ QlQ vÉgÉAiÀÄ ªÉÄÃ¯É ªÀÄÆqÀÄvÀÛzÉ. EzÀgÀ°è £Á®ÄÌ DAiÉÄÌUÀ½gÀÄvÀÛªÉ.

 £ÀÄr ºÉÆ¸À zÀ̧ ÁÛªÉÃdÄ (Nudi New Document)

 JZï.n.JA.J¯ï PÀqÀvÀ (HTML File)

 E¹Ì ¥ÀoÀå PÀqÀvÀ (ISCII Text File)

 CPÀëgÀ s̈ÁUÀ ¥ÀoÀå PÀqÀvÀ (Glyph Text File)

EªÀÅUÀ¼À°è ¤ªÀÄUÉ É̈ÃPÁzÀÄzÀ£ÀÄß DAiÉÄÌ ªÀiÁrPÉÆAqÀÄ Ok UÀÄArAiÀÄ£ÀÄß MwÛzÉÆqÀ£É Nudi1 JA§
ºÉÆ¸À PÀqÀvÀzÀ ¥ÀgÀzÉ ªÀÄÆqÀÄvÀÛzÉ.

¥Àj«r ¥ÀnÖ :
PÀqÀvÀ ¸ÀA¥ÁzÀ£É «£Áå¸À DAiÉÄÌ vÉÆÃj¸ÀÄ G¥ÀPÀgÀtUÀ¼ÀÄ QlQ ¸ÀºÁAiÀÄ

PÀqÀvÀ:

`PÀqÀvÀ' ªÉÄÃ¯É ¸ÀÆZÀPÀªÀ£ÀÄß MAiÀiÁÝUÀ MAzÀÄ G¥À¥Àj«r ¥ÀnÖ ªÀÄÆqÀÄvÀÛzÉ. £Á®ÄÌ UÀÄA¥ÀÄUÀ¼À°è
ºÀvÀÄÛ ««zsÀ DAiÉÄÌUÀ¼ÀÄ EzÀgÀ°èªÉ.

1. ºÉÆ¸À, vÉUÉ, ªÀÄÄZÀÄÑ, G½¸ÀÄ, CAvÉG½¸ÀÄ, AiÀÄÄnJ¥sóï-16gÀAvÉ G½¸ÀÄ, AiÀÄÄnJ¥sóï-16gÀAvÉ
G½¸ÀÄ
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2. ªÀÄÄ¢æ̧ ÀÄ, ªÀÄÄzÀæt ªÀÄÄ£ÉÆßÃl, ªÀÄÄzÀæt ¹zÀÞvÉ
3. EwÛÃa£À PÀqÀvÀUÀ¼ÀÄ
4. ¤UÀð«Ä¸ÀÄ

À̧A¥ÁzÀ£É:

`¸ÀA¥ÁzÀ£É' ¥Àj«rAiÀÄ ªÉÄÃ¯É ¸ÀÆZÀPÀªÀ£ÀÄß MAiÀiÁÝUÀ ªÀÄÆgÀÄ UÀÄA¥ÀÄUÀ¼À°è «AUÀr¹gÀÄªÀ JAlÄ
DAiÉÄÌUÀ¼ÀÄ zÉÆgÉAiÀÄÄvÀÛªÉ.

1. gÀzÀÄÝªÀiÁqÀÄ
2. PÀvÀÛj¸ÀÄ, £ÀPÀ°¸ÀÄ, CAn¸ÀÄ, J¯ÁèDAiÉÄÌªÀiÁqÀÄ
3. ºÀÄqÀÄPÀÄ, ªÀÄÄAzÉºÀÄqÀÄPÀÄ, §zÀ°¸ÀÄ
4. DAiÉÄÌUÀ¼ÀÄ...

«£Áå À̧:

`«£Áå¸À' ¥Àj«rAiÀÄ ªÉÄÃ¯É ¸ÀÆZÀPÀªÀ£ÀÄß MAiÀiÁÝUÀ LzÀÄ UÀÄA¥ÀÄUÀ¼À°è MlÄÖ MA§Vàäû DAiÉÄÌUÀ¼ÀÄ
zÉÆgÉAiÀÄÄvÀÛªÉ.

1. zÀ¥Àà CPÀëgÀ, NgÉ CPÀëgÀ, PÉ¼ÀUÉgÉ
2. CqÀØUÉgÉ
3. UÁvÀæ »VÎ¸ÀÄ, UÁvÀæ PÀÄVÎ¸ÀÄ
4. CPÀëgÀzÀ §tÚ, »A s̈ÁUÀzÀ §tÚ
5. §Ä¯Él£ÀÄß Ȩ́Ãj¸ÀÄ

DAiÉÄÌ:

`DAiÉÄÌ' ¥Àj«rAiÀÄ ªÉÄÃ¯É ¸ÀÆZÀPÀªÀ£ÀÄß
MAiÀiÁÝUÀ JAlÄ DAiÉÄÌUÀ¼ÀÄ zÉÆgÉAiÀÄÄvÀÛªÉ.
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vÉÆÃj À̧Ä:

`vÉÆÃj¸ÀÄ' ¥Àj«rAiÀÄ ªÉÄÃ¯É
¸ÀÆZÀPÀªÀ£ÀÄß MAiÀiÁÝUÀ JgÀqÀÄ DAiÉÄÌUÀ¼ÀÄ
zÉÆgÉAiÀÄÄvÀÛªÉ.

1. G¥ÀPÀgÀt ¥ÀnÖ - ºÉÆ¸ÀPÀqÀvÀ, vÉgÉ
ªÀÄÄAvÁzÀ DAiÉÄÌ G¥ÀPÀgÀtUÀ¼ÀÄ
ºÁUÀÆ £ÀÄr ¯ÁAbÀ£À EgÀÄªÀ
G¥ÀPÀgÀt ¥ÀnÖAiÀÄ£ÀÄß
¥ÀæzÀ²ð¹gÀ®Ä/ªÀÄgÉªÀiÁqÀ®Ä

2. ¹Üw ¥ÀnÖ - ¥ÀzÀ ¸ÀA¸ÁÌgÀPÀ CAPÀtzÀ PÉ¼ÀV£À ¹Üw ¥ÀnÖAiÀÄ£ÀÄß ¥ÀæzÀ²ð¸À®Ä/ªÀÄgÉªÀiÁqÀ®Ä
G¥ÀPÀgÀtUÀ¼ÀÄ: ¥ÀzÀ ¥ÀjÃPÀëPÀ

QlQ:

`QlQ' ¥Àj«rAiÀÄ ªÉÄÃ¯É ¸ÀÆZÀPÀªÀ£ÀÄß MAiÀiÁÝUÀ JgÀqÀÄ UÀÄA¥ÀÄUÀ¼À°è LzÀÄ DAiÉÄÌUÀ¼ÀÄ
zÉÆgÉAiÀÄÄvÀÛªÉ.

1. £ÉÃgÀ £ÀÄr

2. ºÉÆ¸À QlQ, ªÉÄÃ¯É eÉÆÃr¸ÀÄ, ¸ÀªÀÄªÁV eÉÆÃr¸ÀÄ, ¯ÁAbÀ£À (Icon) eÉÆÃr¸ÀÄ

À̧ºÁAiÀÄ:

`¸ÀºÁAiÀÄ' ¥Àj«rAiÀÄ ªÉÄÃ¯É ¸ÀÆZÀPÀªÀ£ÀÄß MAiÀiÁÝUÀ JgÀqÀÄ UÀÄA¥ÀÄUÀ¼À°è ªÀÄÆgÀÄ DAiÉÄÌUÀ¼ÀÄ
zÉÆgÉAiÀÄÄvÀÛªÉ.

1. ¸ÀºÁAiÀÄ ¥Àj«r, QÃ°ªÀÄuÉ «£Áå¸À
2. £ÀÄrAiÀÄ§UÉÎ

EvÀgÀ vÀAvÁæA±ÀUÀ¼À°è `£ÀÄr'AiÀÄ §¼ÀPÉ

 £ÀÄr ¥ÀzÀ̧ ÀA¸ÁÌgÀPÀzÀ QlQ DAiÉÄÌAiÀÄ `£ÉÃgÀ£ÀÄr' AiÀÄ£ÀÄß DAiÉÄÌ ªÀiÁr.

 £ÀÄr ¸ÀzÀ̧ ÀA¸ÁÌgÀPÀªÀÅ PÁtzÁV ¯ÁAbÀ£ÀªÀÅ vÉgÉAiÀÄ PÉ¼ÀUÉ §®ªÀÄÆ¯ÉAiÀÄ°è PÀÆgÀÄvÀÛzÉ.

 MSWORD, EXCEL, POWER POINT, PAGEMAKER EvÁå¢ J¯Áè vÀAvÁæA±ÀUÀ¼À®Æè
PÀ£ÀßqÀªÀ£ÀÄß §¼À̧ À®Ä FUÀ ¸ÁzsÀåªÁUÀÄvÀÛzÉ.
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«±ÉÃµÀvÉ ºÁUÀÆ G¥ÀAiÀÄÄPÀÛvÉUÀ¼ÀÄ

 ¸ÀPÁðgÀªÀÅ ¤UÀ¢¥Àr¹gÀÄªÀ ²µÀÖvÉ, KPÀgÀÆ¥ÀvÉUÀ¼À£ÀÄß M¼ÀUÉÆArzÉ.

 GavÀªÁV zÉÆgÀPÀÄvÀÛzÉ.

 PÀ£ÀßqÀ ªÀiÁ»wUÀ¼À CPÁgÁ¢ «AUÀqÀuÉAiÀÄ ¸Ë® s̈ÀåªÀ£ÀÄß ºÉÆA¢zÉ;

 ºÀÄqÀÄPÀÄ, ºÀÄqÀÄPÀÄ-§zÀ°¸ÀÄ ªÀÄÄAvÁzÀ ¸Ë® s̈ÀåUÀ¼À£ÀÄß PÀ£ÀßqÀzÀ̄ ÉèÃ ¤ÃqÀ̄ ÁVzÉ;

 §ºÀÄªÀÄÄRåªÁV CPÁðªÉÇwÛ£À ªÀÄvÀÄÛ EvÀgÀ ¸ÀªÀÄ¸ÉåUÀ½UÉ ¸ÀªÀÄ¥ÀðPÀªÁzÀ ¥ÀjºÁgÀUÀ¼À£ÀÄß MzÀV¹zÉ;

 zÀvÀÛ ¸ÀA¸ÀÌgÀuÉUÉ CUÀvÀåªÁzÀ C£ÀÄPÀÆ®vÉUÀ¼À£ÀÄß MzÀV¹zÉ;

 C£ÉÃPÀ CPÀëgÀ±ÉÊ°UÀ¼À£ÀÄß ¤ÃqÀ̄ ÁVzÉ;

 ¥ÀzÀ̧ ÀA¸ÀÌgÀuÉUÉ ªÀÄvÀÛµÀÄÖ ¸Ë® s̈ÀåUÀ¼À£ÀÄß ¤ÃrzÉ;

 CAvÀgÀeÁ® ªÀÄvÀÄÛ «zÀÄå£Áä£À CAZÉ PÉëÃvÀæUÀ¼À®Æè PÀ£ÀßqÀªÀ£ÀÄß AiÀÄ±À¹éAiÀiÁV §¼À̧ À®Ä
¸ÁzsÀåªÁV¹zÉ;

 zÀvÀÛ ¸ÀA¸ÀÌ gÀuÉAiÀÄ ¸ÀAzÀ s̈ÀðUÀ¼À°è, MAzÉÃ ¥ÀzÀUÀÄZÀÒzÀ°è wÃgÀ C¤ªÁAiÀÄðªÁV PÀ£ÀßqÀ ºÁUÀÆ
EAVèµï JgÀqÀÆ s̈ÁµÉUÀ¼À°è ªÀiÁ»wUÀ¼À£ÀÄß zÁR°¹ §¼À̧ À̈ ÉÃPÁzÀgÉ CzÀPÉÌ CUÀvÀåªÁzÀ
¢é̈ sÁµÁvÀäPÀ CPÀëgÀ ±ÉÊ°AiÀÄ£ÀÄß ¤ÃqÀ̄ ÁVzÉ ºÁUÀÆ EzÀPÉÌ CUÀvÀåªÁzÀ vÀAvÁæA±ÀªÀ£ÀÄß
C©üªÀÈ¢ÞUÉÆ½¸À̄ ÁVzÉ;

 £ÀÄrAiÀÄ°è QÃ°¹zÀ ªÀiÁ»wUÀ¼À£ÀÄß AiÀÄÆ¤PÉÆÃqï ºÁUÀÆ AiÀÄÄnJ¥sóï8 À̧APÉÃvÀUÀ¼À
PÀqÀvÀUÀ¼ÁVAiÀÄÆ PÁ¦qÀ§ºÀÄzÁVzÉ;

 ¥ÀzÀ¥ÀjÃPÉë ¸Ë® s̈ÀåªÀ£ÀÄß ¤ÃqÀ̄ ÁVzÉ; PÀ£ÀßqÀPÉÌ CUÀvÀåªÁzÀ D£Àé¬ÄPÀ vÀAvÁæA±ÀUÀ¼À£ÀÄß

C©üªÀÈ¢ÞUÉÆ½¸À®Ä CUÀvÀåªÁzÀ vÀAvÁæA±À C©üªÀÈ¢Þ ¸À®PÀgÀuÉUÀ¼À£ÀÄß (Software Development

Kit) ¤ÃqÀ̄ ÁVzÉ.

§¼ÀPÉAiÀÄ PÉëÃvÀæUÀ¼ÀÄ
 «AqÉÆÃ¸ï (95, 98, J£ïn, 2000, JPïì¦) CAPÀtzÀ J®è D£Àé¬ÄPÀ (C¦èPÉÃ±À£ï) vÀAvÁæA±ÀUÀ¼ÀÄ

 ¯ÉÆÃl¸ï ¸ÁägïÖ À̧Æmï

 J®è jÃwAiÀÄ ¥ÀzÀ ¸ÀA¸ÀÌgÀuÉ (ªÀqïð ¥Áæ̧ É¹AUï) (JAJ¸ï D¦üÃ¸ÀÄ, ¸ÁÖgï D¦üÃ¸ÀÄ,
¥ÉÃeïªÉÄÃPÀgï EvÁå¢)

 zÀvÀÛ ¸ÀA¸ÀÌgÀuÉ (qÉÃmÁ ¥Áæ¸É¹AUï) (JAJ¸ï DPÉì¸ï, «µÀÄC¯ï ¨ÉÃ¹Pï, J¸ïPÀÆåJ¯ï, CgÁPÀ̄ ï,
«µÀÄC¯ï ¥sÁPïì¥ÉÆæÃ EvÁå¢)

 DAvÀjPÀeÁ® (EAmÁæ£Émï) ºÁUÀÆ CAvÀgÀeÁ® (ªÉ̈ ï¸ÉÊmï) C£ÀéAiÀÄUÀ¼ÀÄ, «-CAZÉ
(EAlgï£Émï) ¸ÉÃªÉUÀ¼ÀÄ.



“ £À£Àß DwäÃAiÀÄ «zÁåyðUÀ½UÉ ¤ÃqÀÄwÛÃgÀÄªÀ QgÀÄPÁtÂPÉ ”

DwäÃAiÀÄgÉÃ, £À£Àß fÃªÀ£ÀzÀÀ CªÀÄÆ®åªÁzÀ À̧A¥ÀvÉÛAzÀgÉ “£À£Àß

«zÁåyð §¼ÀUÀ” £À£Àß ±Á¯ÉAiÀÄ «zÁåyð §¼ÀUÀ £À£Àß£ÀÄ

dªÁ¨ÁÝjAiÀÄÄvÀ ²PÀëPÀ£ÁßV¹zÁÝgÉ. £À£Àß£ÀÄß ¨É¼À¹ À̧AvÉÆÃµÀ¥ÀlÄÖ

ºÉªÉÄä¬ÄAzÀ £À£Àß §UÉÎ ¥Àæ±ÀA¹zÀ «zÁåyðUÀ½UÉ CªÀgÀ ¦æÃwAiÀÄ

UÀÄgÀÄªÁV F ¥ÀÄ À̧ÛPÀªÀ£ÀÄß QgÀÄPÁtÂPÉAiÀiÁV ¤ªÀÄä PÉÊVqÀÄwÛzÉÝÃ£É.

F ¥ÀÄ À̧ÛPÀªÀÅ £À£Àß «zÁåyðUÀ¼À eÁÕ£ÀªÀ£ÀÄß ºÉaÑ À̧°, CªÀgÀÄ ¥ÀjÃPÉëUÀ¼À°è

AiÀÄ±À À̧Äì UÀ½ À̧ÄªÀAvÁUÀ°, CªÀgÀ fÃªÀ£À À̧ÄRªÁVgÀ° JAzÀÄ ºÁgÉÊ À̧ÄªÉ...............

EAw ¤ªÀÄä

QÃwð PÀÄªÀiÁgï ºÉZï.JA
PÀA¥ÀÆålgï ²PÀëPÀgÀÄ

ªÉÆ.zÉ.ªÀ.±Á¯É, ¨ÉÃ®ÆgÀÄ mË£ï

K Karnataka Residential Educational Institutional Society
#179, Roopa Complex, 1st Main Road Sheshadripuram, Bangalore 560 020
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